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Αυτό το βιβλίο στηρίζεται στις λειτουργίες του προγράμματος Actrix της εταιρείας Autodesk Inc. Όλες οι οθόνες και οι τεχνολογίες που χρησιμοποιούνται είναι από το συγκεκριμένο πρόγραμμα ή από το λειτουργικό Microsoft Windows και ιδιοκτησία των αντίστοιχων εταιρειών.

1 ΑΠΟ ΤΟ ΜΟΛΥΒΙ ΣΤΟΝ Η/Υ

Σε αυτό το κεφάλαιο θα. ξεχωρίσουμε τα προγράμματα σχεδιασμού ανάλογα με τον τρόπο λειτουργίας τους αλλά και με το σκοπό τους. Υπάρχουν προγράμματα που δουλεύουν διανυσματικά και χαρτογραφικά. Ανάλογα με τους αυτοματισμούς τους, έχουμε προγράμματα μηχανολογικά, αρχιτεκτονικά, ηλεκτρομηχανολογικά κλπ..

Στη συνέχεια θα δούμε τα βασικά εργαλεία σχεδιασμού και τις βασικές έννοιες και ρυθμίσεις που αφορούν το τεχνικό σχέδιο σε έναν υπολογιστή.

1.1 Η εισαγωγή του Η/Υ στο τεχνικό σχέδιο

Οι εξελίξεις στον χώρο τον ηλεκτρονικών υπολογιστών δεν άργησαν να φτάσουν και μέχρι τον τομέα του τεχνικού σχεδίου. Με τα προγράμματα που άρχισαν να αναπτύσσονται και να εξελίσσονται στο πέρασμα του χρόνου, έρχονται αυτά τα μηχανήματα να διευκολύνουν την καθημερινή εργασία του σχεδιαστή, του μηχανικού, του αρχιτέκτονα, αλλά και όποιου άλλου έχει άμεσα σχέση με το τεχνικό σχέδιο. Και η εξέλιξη δεν σταματάει! Συνέχεια προσθέτονται κι άλλοι αυτοματισμοί και ευκολίες στα σχεδιαστικά προγράμματα, έτσι ώστε πολλά από αυτά μπορούν να τα χειρίζονται ακόμα και μη ειδικοί. Υπάρχουν εκδόσεις προγραμμάτων που απευθύνονται σε απλούς χρήστες, οι οποίοι θέλουν με λίγες κινήσεις να κάνουν ένα απλό σχέδιο π.χ. του σπιτιού τους, για να δοκιμάσουν την διαρρύθμιση των επίπλων. Ειδικά για απαιτητικούς χρήστες έχουν εμπλουτιστεί προγράμματα με τόσες πολλές λειτουργίες, που απαιτείται χρόνος και συστηματική προσπάθεια για την σωστή εκμάθηση και χρήση τους.

Αρχικά τα σχεδιαστικά προγράμματα δεν είχαν πολλές ευκολίες και ο χρήστης έπρεπε να γνωρίζει τις διάφορες λειτουργίες τους πάρα πολύ καλά, απομνημονεύοντας πολλές φορές πλήθος εντολών. Σιγά σιγά άρχισαν να προσθέτονται διάφοροι αυτοματισμοί, οι οποίοι βοηθούν στην γρήγορη εκτέλεση μιας σειράς εντολών με μία μόνο κίνηση, στον υπολογισμό διαφόρων στοιχείων, αλλά και στον καθορισμό των σημείων σχεδιασμού επάνω στο χαρτί. Η γενικότερη τάση στην αποφυγή της κίνησης του κεφαλιού από την οθόνη στο πληκτρολόγιο και πάλι πίσω πληκτρολογήσεις (head-up design), έφερε ως αποτέλεσμα να δημιουργηθούν τόσο ισχυρά εργαλεία και αυτοματισμοί, ώστε να χρειάζονται όλο και πιο λίγες.

Με βάση αυτά τα ισχυρά προγράμματα σχεδιασμού, έχουν αναπτυχθεί προγράμματα που εκμεταλλεύονται τις δυνατότητές τους και εκτελούν μία σειρά ελέγχων και σχεδιασμών αυτόματα. Για να σχεδιάσουμε μία πόρτα σε έναν τοίχο, έπρεπε κάποτε  να σχεδιάσουμε πρώτα τον τοίχο. Μετά έπρεπε να τον κόψουμε και να τοποθετήσουμε στο άνοιγμα την πόρτα, την οποία επίσης θα πρέπει να σχεδιάσουμε.  Τώρα υπάρχουν προγράμματα, στα οποία απλώς ορίζουμε κάποια χαρακτηριστικά της πόρτας και αυτά την τοποθετούν στο σωστό σημείο. 

Πολλά από τα προγράμματα σχεδιασμού, έχουν την δυνατότητα και τρισδιάστατου σχεδίου. Με τα εργαλεία που προσφέρουν, βοηθούν στην κατασκευή αντικειμένων στον χώρο, ώστε να μπορούμε εύκολα να δούμε τις διάφορες όψεις τους και να ζητήσουμε διάφορους υπολογισμούς. Με λίγη δουλειά παραπάνω, καθορίζοντας τα υλικά από τα οποία αποτελείται το συγκεκριμένο αντικείμενο, μπορούμε να το αποδώσουμε ως φωτογραφία. Έχοντας αυτή την φωτογραφία στα χέρια, μπορεί ακόμα και αυτός που δεν ξέρει να διαβάσει σχέδια να καταλάβει περί τίνος πρόκειται.

1.2 Είδη αρχείων σχεδίων / φωτογραφιών

Τα σχεδιαστικά προγράμματα χωρίζονται σε δύο κατηγορίες, ανάλογα με τον τρόπο που χειρίζονται τα στοιχειώδη αντικείμενα σχεδιασμού:

· Διανυσματικά XE "Διανυσματικά σχέδια"  (vector): Σχεδιάζουμε γεωμετρικά σχήματα, τα οποία προσδιορίζονται από τα βασικά τους χαρακτηριστικά, π.χ. σε ένα ευθύγραμμο τμήμα, τις συντεταγμένες αρχής και τέλους του. Για αυτό τον λόγο μπορούμε εύκολα να τους αλλάζουμε το μέγεθος δίχως απώλειες στην ποιότητα του σχεδίου. 
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Χαρτογραφικά (bitmap): Η γραμμή αποτελείται από πολλούς κόκκους. Για κάθε κόκκο πρέπει να υπάρχουν τα χαρακτηριστικά του (συντεταγμένες, χρώμα κτλ.).  Σε περίπτωση μεγέθυνσης του αρχείου, δεν υπάρχουν τα απαραίτητα στοιχεία για τα ενδιάμεσα σημεία, οπότε το σχέδιο χάνει σε ευκρίνεια. Ενα ευθύγραμμο τμήμα π.χ. δημιουργείται βάζοντας πολλούς κόκκους έναν δίπλα στον άλλο. Όταν αυτή η γραμμή μεγεθυνθεί, η απόσταση αυτών των κόκκων μεγαλώνει και η γραμμή ξεχωρίζει στα επιμέρους συστατικά της.

Τα προγράμματα τεχνικού σχεδίου είναι διανυσματικά. Καταλαμβάνουν έτσι λιγότερο χώρο στον σκληρό δίσκο, αλλά και οι διαστάσεις τους και οι κλίμακες μπορούν να αλλάξουν πιο εύκολα και χωρίς απώλειες.

Τις φωτογραφίες, επειδή δεν μπορούμε εύκολα να τις αποδώσουμε με γραμμές και κύκλους, τις επεξεργαζόμαστε με χαρτογραφικά προγράμματα. Εκεί για την ευκρίνεια παίζουν πιο πολύ ρόλο η ανάλυση (πόσοι κόκκοι υπάρχουν) και το πλήθος των χρωμάτων.


1.3 Ο προσανατολισμός μας σε ένα πρόγραμμα

Μόλις ξεκινήσουμε το πρόγραμμα, αυτό μας ζητάει να ορίσουμε το πρότυπο σχέδιο. Ανάλογα με την επιλογή μας, θα φορτωθούν ορισμένες βιβλιοθήκες και θα γίνουν βασικές ρυθμίσεις. Υπάρχει όμως και επιλογή, η οποία δεν φορτώνει τίποτα (Blank Template). Μόλις περάσουμε αυτό, το πρώτο βήμα ρυθμίσεων, βλέπουμε ότι η οθόνη μας χωρίζεται σε διαφορετικές περιοχές. Η κάθε μία από αυτές έχει συγκεκριμένο ρόλο.

Στην πρώτη σειρά, στην πάνω άκρη της οθόνης μας, υπάρχει το όνομα του προγράμματος και δίπλα του το όνομα του αρχείου που δουλεύουμε αυτή την στιγμή. Αν δεν έχουμε αποθηκεύσει ακόμα το σχέδιο, δεν του έχουμε ορίσει κάποιο όνομα. Σε αυτή την περίπτωση εμφανίζεται με το όνομα 'Drawing 1'.

Στην αμέσως επόμενη σειρά, υπάρχουν τα διάφορα μενού XE "μενού" . Όλες οι εντολές που δέχεται το πρόγραμμα βρίσκονται εδώ ομαδοποιημένες.

Για να εντοπίσουμε και να ενεργοποιήσουμε κάποιο εργαλείο, θα πρέπει να ψάξουμε στα μενού. Πολλά προγράμματα τοποθετούν εικονίδια στην οθόνη, με τα οποία επιλέγουμε κατευθείαν τα συγκεκριμένα εργαλεία. Γλιτώνουμε την χρονοβόρο διαδικασία αναζήτησής τους. Αυτά τα εικονίδια είναι ομαδοποιημένα ανά είδος εργασίας σε γραμμές εργαλείων XE "γραμμές εργαλείων"  (toolbars XE "toolbars" ) και εμφανίζονται κυρίως στις επόμενες σειρές. Μπορούν όμως να τοποθετηθούν και σε διαφορετικά σημεία της οθόνης μας. Ανάλογα με το σχέδιο που κάνουμε, εμφανίζουμε τις κατάλληλες γραμμές εργαλείων, για να έχουμε στην διάθεσή μας την μέγιστη σχεδιαστική επιφάνεια
. 

Αριστερά ή δεξιά στην οθόνη μας μπορούν να εμφανιστούν και κάποια παράθυρα, τα οποία έχουν όλα τα χαρακτηριστικά του αντικειμένου που είναι επιλεγμένο (property window XE "property window" ) ή μας προσφέρουν βιβλιοθήκες έτοιμων συμβόλων και σχεδίων (activeShapes XE "activeShapes" ) 

Το μεγαλύτερο μέρος της οθόνης μας το καταλαμβάνει η περιοχή σχεδίασης XE "περιοχή σχεδίασης" . Για να μπορέσουμε να αντιληφθούμε το πραγματικό μέγεθος του σχεδίου μας, εμφανίζεται η περιοχή που αντιστοιχεί στο χαρτί που θα εκτυπώσουμε λευκή. Μέσα σε αυτή την περιοχή, μπορούμε να εμφανίσουμε έναν κάνναβο.

Στην πάνω και στην αριστερή πλευρά της περιοχής σχεδίασης υπάρχουν χάρακες XE "χάρακες"  (rulers XE "rulers" ). Οι ενδείξεις επάνω τους εξαρτώνται από το σημείο που αρχίζουν την μέτρηση (η αρχική ρύθμιση είναι η αριστερή κάτω γωνία του φύλλου εργασίας) και την κλίμακα που έχουμε ορίσει. Μπορούμε να αλλάξουμε το σημείο, από το οποίο αρχίζουν την μέτρηση (drawing plane origin XE "drawing plane origin" ), από το μενού format - coordinates. Για να εμφανίσουμε τους χάρακες και τον κάνναβο, αρκεί να τα ενεργοποιήσουμε από το μενού view (βλέπε δίπλα).

Στην τελευταία σειρά (status bar XE "status bar" ) θα βρούμε μία σύντομη βοήθεια και τις συντεταγμένες στις οποίες βρίσκεται ο δείκτης του ποντικιού μας, μόλις ξεκινήσουμε κάποια διαδικασία (είτε σχεδιασμού, είτε τροποποίησης).

Ο δείκτης του ποντικιού μας αλλάζει μορφή, ανάλογα με τη διαδικασία στην οποία βρισκόμαστε. Όταν δεν έχουμε διαλέξει κάποιο εργαλείο, ο δείκτης είναι ένα βελάκι. Μόλις επιλέξουμε π.χ. τον σχεδιασμό μίας γραμμής ή ενός άλλου αντικειμένου, μεταμορφώνεται σε ένα σταυρόνημα.

1.4 Η αρχειοθέτηση

Ίσως η βασικότερη λειτουργία ενός προγράμματος είναι η δυνατότητά του να αποθηκεύει δεδομένα για μεγάλα χρονικά διαστήματα. Ένα αποθηκευμένο σχέδιο μπορεί να το ξαναφορτώσει στην μνήμη του έτσι ώστε να το εκτυπώσουμε ή ακόμα και να το επεξεργαστούμε.

Οι βασικές λειτουργίες της αρχειοθέτησης είναι τρεις:

· το άνοιγμα XE "άνοιγμα"  ή φόρτωμα (open XE "open" 

 XE "open" )

· η αποθήκευση XE "αποθήκευση"  (save XE "save" ) και

· η αποθήκευση με άλλο όνομα XE "αποθήκευση: με άλλο όνομα"  (save XE "save:save as..."  as…)

Εκτός από αυτές της λειτουργίες, υπάρχουν και εντολές

· για την δημιουργία νέου σχεδίου XE "δημιουργία νέου σχεδίου"  (new XE "new" )

· για το κλείσιμο ενός σχεδίου XE "κλείσιμο ενός σχεδίου"  (close XE "close" )

Όπως και με άλλες εντολές, μπορούμε να τις ενεργοποιήσουμε είτε από την γραμμή εργαλείων είτε από τα μενού.

Στο ίδιο μενού εμφανίζεται μία λίστα των τελευταίων επεξεργασμένων αρχείων. Επιλέγοντας ένα από αυτά, φορτώνεται αμέσως στην μνήμη, χωρίς να χρειαστεί να το αναζητήσουμε στον σκληρό δίσκο.

1.5 Οι βασικές ρυθμίσεις

Για να μπορούμε να παρακολουθούμε την πορεία του σχεδίου, το πρόγραμμα μας εμφανίζει μία περιοχή της οθόνης λευκή. Αυτή αντιστοιχεί στο χαρτί που θα εκτυπώσουμε και η εμφάνισή της αλλάζει ανάλογα με το μέγεθος του χαρτιού XE "μέγεθος του χαρτιού" .

Το μέγεθος του χαρτιού XE "μέγεθος χαρτιού"  στο οποίο θα εκτυπώσουμε, το ορίζουμε από το μενού File > Page Setup. Εκεί υπάρχουν και ρυθμίσεις που αφορούν τα περιθώρια και τον προσανατολισμό του χαρτιού.

Η ρύθμιση της κλίμακας γίνεται από το μενού Format > Scale. Στο παράθυρο που ανοίγει ορίζουμε την κλίμακα του σχεδίου μας.

Μέσα στην επιφάνεια που αντιστοιχεί στο χαρτί μας, εμφανίζεται ένας κάνναβος XE "κάνναβος"  (grid XE "grid" ). Ο κάνναβος αυτός είναι χρήσιμος για να αντιλαμβανόμαστε τα μεγέθη των αντικειμένων που σχεδιάζουμε, αλλά και για να πετύχουμε ακρίβεια στον σχεδιασμό. Για να τον ενεργοποιήσουμε, θα βρούμε στο μενού Format > Grid επιλογές που αφορούν την εμφάνιση και το μέγεθός του. Θα βοηθηθούμε πολύ στο σχέδιο, αν τον ρυθμίσουμε σε ένα βασικό μέγεθος του σχεδίου.

Η μονάδα μέτρησης του σχεδίου μας καθορίζεται στο μενού Format > Units. Εκεί υπάρχουν ξεχωριστές ρυθμίσεις για την μονάδα μέτρησης των αντικειμένων που θα σχεδιάσουμε και για τα κείμενα και τα πάχη των γραμμών.

Οι παραπάνω ρυθμίσεις βρίσκονται στο ίδιο παράθυρο (Drafting Settings), αλλά σε διαφορετικές καρτέλες. Μπορούμε πολύ εύκολα να μεταβούμε από την μία στην άλλη, απλά επιλέγοντας με το ποντίκι την καρτέλα που μας ενδιαφέρει.

Τις ίδιες ρυθμίσεις μπορούμε να κάνουμε και πατώντας το δεξί πλήκτρο του ποντικιού σε ένα κενό σημείο του σχεδίου μας. Στις επιλογές θα βρούμε όλες τις παραπάνω ρυθμίσεις.

1.6 Εργαλεία καθορισμού σημείων

Ένα από τα πλεονεκτήματα του ηλεκτρονικού σχεδίου είναι η μεγάλη ακρίβεια που μπορούμε να πετύχουμε. Θα πρέπει όμως να δουλεύουμε με κάποιες συγκεκριμένες μεθόδους οι οποίες θα μας δώσουν τα σωστά αποτελέσματα. 

Χρησιμοποιώντας τις έλξεις XE "έλξεις"  (snaps XE "snaps" ), επιλέγουμε συγκεκριμένα σημεία ενός αντικειμένου. 


Οι έλξεις ενεργοποιούνται από το μενού Tools > AutoSnap. Εκεί ορίζουμε και την απόσταση γύρω από τον δείκτη του ποντικιού που θα ελέγχεται για σημεία έλξης.

Τα σχήματα μας βοηθούν να καταλάβουμε η κάθε έλξη ποιο σημείο επιλέγει.

Endpoints XE "έλξεις:endpoints" :
Τα άκρα
Το ένα από τα δύο άκρα ενός αντικειμένου

Centers XE "έλξεις:centers" :
Τα κέντρα
Το κέντρο κύκλου ή τόξου

Intersections:  XE "έλξεις:intersections"  
Τα σημεία τομής
Το σημείο τομής δύο αντικειμένων

Midpoints:  XE "έλξεις:midpoints" 
Το μέσο
Το μέσο ενός ευθύγραμμου τμήματος

Quadrants:  XE "έλξεις:quadrants" 
Τα τεταρτημόρια
Ένα από τα τεταρτημόρια ενός κύκλου ή τόξου

Tangent:  XE "έλξεις:tangent" 
Εφαπτόμενα
Εφαπτόμενα από έναν κύκλο ή τόξο

Perpendicular:  XE "έλξεις:perpendicular" 
Κάθετα
Κάθετα από ένα αντικείμενο

Sockets:  XE "έλξεις:sockets" 
Υποδοχές
Ειδική υποδοχή που μπορεί να έχουν τα ενεργά σχήματα

Geometry:  XE "έλξεις:geometry" 
Γεωμετρία
Στο κοντινότερο σημείο επάνω σε ένα αντικείμενο

Grid:  XE "έλξεις:grid" 
Κάνναβος
Επάνω στις διασταυρώσεις των βοηθητικών γραμμών του καννάβου

Τις έλξεις μπορούμε να τις επιλέγουμε ακόμα και με ενεργοποιημένο κάποιο εργαλείο, την στιγμή που σχεδιάζουμε. Αυτή η επιλογή γίνεται μόνο από την γραμμή εργαλείων AutoSnap

Οι ενεργές έλξεις εμφανίζονται με διαφορετικό φόντο.

1.7 Εμφάνιση του σχεδίου: Ζουμ XE "Ζουμ" 
Την οθόνη μας θα πρέπει να την φανταστούμε σαν μία φωτογραφική μηχανή, η οποία εστιάζει στο σχέδιό μας και μας το δείχνει από πιο κοντά ή πιο μακριά. Ανάλογα με το ζουμ που κάνουμε, τα σχεδιασμένα αντικείμενα φαίνονται πιο μικρά όταν τα παρατηρούμε από μακριά και πιο μεγάλα όταν πάμε πιο κοντά. Σε καμία από αυτές τις περιπτώσεις το μέγεθος των αντικειμένων στο σχέδιο δεν αλλάζει!

Στο αριστερό παράδειγμα βλέπουμε την εμφάνιση του σχεδίου με ρύθμιση ζουμ στα 100%, ενώ στο δεξί η ρύθμιση είναι 400%.

Ειδικά για τον καθορισμό της περιοχής του σχεδίου που θα μεγεθυνθεί υπάρχουν διάφορα εργαλεία:

Pan XE "Pan" 
Μετακινούμε το σχέδιό μας (όλο το φύλλο εργασίας)

Zoom XE "Zoom"  
In/Out: Κρατάμε το αριστερό πλήκτρο του ποντικιού πατημένο και το μετακινούμε πάνω / κάτω. Όταν το μετακινούμε προς τα πάνω, το σχέδιο έρχεται πιο κοντά, ενώ όταν το μετακινούμε προς τα κάτω, αυτό φεύγει πιο μακριά.

Zoom Window
Καθορίζουμε μία περιοχή του σχεδίου μας, την οποία θέλουμε να δούμε σε μεγέθυνση.

Zoom Control
Από αυτή την λίστα επιλέγουμε το ποσοστό της μεγέθυνσης που θέλουμε να κάνουμε ή την προσαρμογή της οθόνης μας σε συγκεκριμένη περιοχή του σχεδίου.

Άσκηση: Άνοιξε ένα από τα σχέδια που συνοδεύουν το πρόγραμμα ως παραδείγματα. Δοκίμασε τα διάφορα εργαλεία ζουμ.

1.8 Βασικές λειτουργίες - χειρισμοί

Για να  XE "επιλογή:αντικειμένου" επιλέξουμε κάποια αντικείμενα, πρέπει να ακυρώσουμε πρώτα τυχόν ενεργοποιημένο εργαλείο σχεδιασμού πατώντας το πλήκτρο ESC ή πατώντας το εικονίδιο επιλογών (select XE "select" ).

Μετά 

1. πηγαίνουμε τον δείκτη του ποντικιού επάνω στο αντικείμενο και

2. πατάμε το αριστερό πλήκτρο του ποντικιού.

Αν θέλουμε να επιλέξουμε πολλά αντικείμενα, μπορούμε

· να κρατήσουμε πατημένο το πλήκτρο 'Shift' και να επιλέξουμε διαδοχικά όλα τα αντικείμενα ή 

· να επιλέξουμε την περιοχή μέσα στην οποία βρίσκονται τα αντικείμενα.


Όταν θέλουμε να σβήσουμε XE "διαγραφή:αντικειμένου"  ένα σχεδιασμένο αντικείμενο, απλά το επιλέγουμε και πατάμε το πλήκτρο DEL (ή Delete XE "Delete" ).

Αυτή την λειτουργία θα τη βρούμε και στο μενού Edit.

Πολύ χρήσιμη είναι η δυνατότητα του undo XE "undo" , δηλαδή η ακύρωση XE "ακύρωση"  της τελευταίας μας κίνησης. Ενεργοποιείται από το μενού Edit ή με το εικονίδιο 

Μόλις κάνουμε μία λάθος κίνηση, επιλέγουμε την ακύρωσή της, επαναφέροντας έτσι γρήγορα το σχέδιο στην προηγούμενη κατάσταση.

Με το πλήκτρο F9 ενεργοποιούμε το παράθυρο των ιδιοτήτων XE "ιδιότητες αντικειμένων"  των αντικειμένων (Property Window XE "Property Window" ). 

Όταν επιλέξουμε ένα αντικείμενο, στο παράθυρο των ιδιοτήτων του μπορούμε να ελέγξουμε τα χαρακτηριστικά του. Αυτό το παράθυρο ενεργοποιείται και από το μενού view XE "view" .

Από το ίδιο μενού μπορούμε να ελέγξουμε την εμφάνιση κι άλλων βοηθητικών εργαλείων, όπως του χάρακα, του καννάβου και των γραμμών εργαλείων.

Αν θέλουμε να αντιγράψουμε XE "αντιγραφή"  ένα ήδη σχεδιασμένο αντικείμενο, απλά κρατάμε πατημένο το πλήκτρο ctrl και σέρνουμε το αντικείμενο σε κάποια απόσταση από την αρχική του θέση.

Το πλήκτρο shift XE "shift"  μας βοηθάει στον σχεδιασμό οι μετακινήσεις να γίνονται μόνο σε συγκεκριμένους άξονες ή γωνίες.

Μπορούμε να ρυθμίσουμε το πρόγραμμα έτσι, ώστε ένα εργαλείο σχεδιασμού να παραμένει ενεργό μέχρι να επιλέξουμε άλλο εργαλείο ή να λειτουργεί μόνο για μία κίνηση. Αυτό γίνεται στο μενού File - Options.


1.9 Επισκόπηση κεφαλαίου

Σε αυτό το κεφάλαιο γνωρίσαμε

· Τα διάφορα είδη αρχείων σχεδίων,

· Τις περιοχές με τα εργαλεία τους στο πρόγραμμά μας,

· Τις βασικές ρυθμίσεις,

· Τις έλξεις,

· Τα εργαλεία 'ζουμ'

· Χρήσιμες λειτουργίες

Τώρα θα πρέπει να ξέρεις:

· Ποια είναι η διαφορά ανάμεσα στα διανυσματικά και χαρτογραφικά αρχεία;

· Ποιοι είναι οι χάρακες και πώς εμφανίζονται;

· Πού βρίσκονται τα εργαλεία της αρχειοθέτησης;

· Ποιες είναι οι βασικές ρυθμίσεις και πού τις αλλάζουμε;

· Πού βρίσκονται οι ρυθμίσεις των έλξεων;

· Πώς αλλάζουμε την εμφάνιση του σχεδίου;

· Πώς ακυρώνουμε την τελευταία μας κίνηση;

· Πώς επιλέγουμε αντικείμενα;

· Πώς ενεργοποιούμε το παράθυρο των ιδιοτήτων;

2 Σχεδιάζουμε - Τροποποιούμε

Αφού είδαμε τις βασικές ρυθμίσεις και την γενικότερη εμφάνιση του προγράμματος, ήρθε η στιγμή να σχεδιάσουμε. Σε αυτό το κεφάλαιο θα μάθουμε να δουλεύουμε με τα σωστά εργαλεία, ώστε να πετύχουμε την ακρίβεια στον σχεδιασμό.

Εκτός από το να τοποθετούμε τις γραμμές στο σχέδιο, πρέπει να ξέρουμε και να τις τροποποιούμε, για να έχουμε το σωστό αποτέλεσμα. Πολλές φορές παίρνουμε το τελικό αποτέλεσμα μετά την τροποποίηση ενός αντικειμένου. 

2.1 Εργαλεία σχεδιασμού

Τα εργαλεία σχεδιασμού είναι πολλά. Σε όλα τα σχεδιαστικά προγράμματα υπάρχουν εργαλεία για να σχεδιάσουμε γραμμές, κύκλους, τόξα και διάφορα άλλα βασικά σχήματα. Για να μπορέσει το πρόγραμμα να τοποθετήσει το σχήμα στην επιφάνεια σχεδιασμού, θα πρέπει να ορίσουμε τα βασικά του χαρακτηριστικά. Ένα ευθύγραμμο τμήμα π.χ. ορίζεται με τα δύο άκρα του, ένας κύκλος βάση του κέντρου και της ακτίνας του, αλλά και βάση τριών μη συνευθειακών σημείων.

Κάθε πρόγραμμα σχεδιασμού διαθέτει εργαλεία για τον σχεδιασμό ευθύγραμμων τμημάτων, τόξων, κύκλων και παραλληλογράμμων τουλάχιστον.

Και τα εργαλεία σχεδιασμού τα επιλέγουμε με δύο τρόπους:

Α) Από το μενού Draw
Β) Από την γραμμή εργαλείων standard ή draw 


Line XE "Line" :
Ευθύγραμμα τμήματα

Polyline XE "Polyline" :
Ένα πολύγραμμο, το οποίο αποτελείται από ευθύγραμμα τμήματα

Arc XE "Arc" : 
Τόξο (αν το επιλέξουμε από τα μενού, έχει τρεις επιλογές: να το σχεδιάσουμε ορίζοντας είτε τις δύο άκρες του, είτε το κέντρο, την ακτίνα και την γωνία του.

Spline XE "Spline" : 
Ομαλή καμπύλη

Rectangle XE "Rectangle" : 
Παραλληλόγραμμο

Circle XE "Circle" : 
Κύκλος

Text XE "Text" : 
Κείμενο

Connector XE "Connector" : 
Αυτόματη γραμμή που ενώνει σχήματα

Για να σχεδιάσουμε ένα ευθύγραμμο τμήμα, επιλέγουμε το εργαλείο Line και κατόπιν καθορίζουμε την αρχή και το τέλος του, πατώντας το αριστερό πλήκτρο του ποντικιού στα συγκεκριμένα σημεία. Τα σημεία αυτά, τα ορίζουμε με διάφορους τρόπους:

Α) Πριν σχεδιάσουμε την γραμμή: Οι έλξεις επιλέγουν συγκεκριμένα σημεία ενός αντικειμένου, είτε για αρχή είτε για τέλος.

Β) Αφού έχουμε σχεδιάσει την γραμμή: Με το πλήκτρο F9 ενεργοποιείται το παράθυρο των ιδιοτήτων XE "παράθυρο των ιδιοτήτων"  (properties XE "properties" ) ενός αντικειμένου. Όταν πρόκειται για ευθύγραμμο τμήμα π.χ. μας εμφανίζει τις συντεταγμένες αρχής και τέλους, αλλά και το μήκος και την γωνία του. Αυτές οι συντεταγμένες αλλάζουν. Αρκεί να τοποθετήσουμε τον δείκτη του ποντικιού μας στην συγκεκριμένη παράμετρο, να πατήσουμε το αριστερό πλήκτρο του και να πληκτρολογήσουμε την καινούρια τιμή.

2.2 Ιδιότητες αντικειμένων

Όλα τα βασικά αντικείμενα που σχεδιάζουμε έχουν κάποιες ιδιότητες. Αυτές, ανάλογα με το αντικείμενο, μπορεί να είναι:

· Χρώμα γραμμής XE "Χρώμα γραμμής"  (Line color)
· Χρώμα γεμίσματος XE "Χρώμα γεμίσματος"  (Fill color)
· Χρώμα διαγράμμισης XE "Χρώμα διαγράμμισης"  (Pattern color)
· Πάχος γραμμής XE "Πάχος γραμμής"  (Line Weight)
· Είδος γραμμής XE "Είδος γραμμής"  (Line Pattern)
· Είδος διαγράμμισης XE "Είδος διαγράμμισης"  (Fill Pattern)
Έχουμε διάφορους τρόπους για να αλλάξουμε κάποια από αυτές τις ιδιότητες. Ο πιο εύκολος και άμεσος τρόπος είναι από την γραμμή εργαλείων format.

Αυτές οι ιδιότητες υπάρχουν και στο παράθυρο των ιδιοτήτων (property window). Και στις δύο περιπτώσεις, θα πρέπει πρώτα να επιλέξουμε το αντικείμενο και μετά την ιδιότητα, που θέλουμε να του δώσουμε.

Πατώντας το δεξί πλήκτρο του ποντικιού την στιγμή που ο δείκτης του βρίσκεται πάνω στο αντικείμενο, ανοίγει ένα παράθυρο, το οποίο μας επιτρέπει να κάνουμε διάφορες ρυθμίσεις. Μεταξύ αυτών των ρυθμίσεων υπάρχουν και κάποιες που ανοίγουν αμέσως το παράθυρο των ιδιοτήτων στην συγκεκριμένη επιλογή. Αν π.χ. θέλουμε να αλλάξουμε το γέμισμα του αντικειμένου, απλά επιλέγουμε 'fill'. Αμέσως ανοίγει το παράθυρο ιδιοτήτων (αν δεν ήταν ήδη στην οθόνη μας) και μάλιστα στις επιλογές που αφορούν το γέμισμα.

Τα κείμενα έχουν και τις δικές τους ιδιότητες (γραμματοσειρά, μέγεθος, μορφή κ.λπ.)

2.3 Σχεδιασμός με έλξεις

Σε προηγούμενο κεφάλαιο μάθαμε για τις έλξεις. Στα παρακάτω παραδείγματα θα μάθουμε να τις εφαρμόζουμε για να πετύχουμε μέγιστη ακρίβεια στο σχέδιο.


Αρχικά απενεργοποιούμε όλες τις έλξεις: 

Παράδειγμα 1ο: 

Ποιες διαφορές παρατηρείς ανάμεσα στα δύο παρακάτω σχέδια; Αν και πρόκειται για το ίδιο σχέδιο, έχει γίνει με δύο διαφορετικούς τρόπους σχεδίασης. Ποιο αποτέλεσμα θεωρείς σωστό;


Στις προηγούμενες εικόνες δεν φάνηκε καμία διαφορά. Αν όμως θελήσουμε να δούμε κάποια λεπτομέρεια, σε αυτή την περίπτωση το σημείο όπου τέμνονται οι δύο γραμμές, εκεί θα φανεί η διαφορά. Χρησιμοποιούμε το εργαλείο 'ζουμ':


Στην αριστερή εικόνα παρατηρούμε, ότι οι δύο γραμμές δεν τέμνονται, ενώ στην δεξιά τέμνονται. Προφανώς δεν έχουν χρησιμοποιηθεί στο αριστερό σχέδιο οι έλξεις. Όταν σχεδιάζουμε, πρέπει να δουλεύουμε με συγκεκριμένες μεθόδους, ώστε να πετυχαίνουμε πάντα την απαραίτητη ακρίβεια.

Παράδειγμα 2ο: 

Θέλουμε να σχεδιάσουμε το παρακάτω αντικείμενο:

Τι παρατηρούμε;

1. Αποτελείται από τόξα, τα οποία δημιουργήθηκαν κόβοντας κύκλους

2. Ο μεγάλος, εξωτερικός κύκλος έχει ακτίνα 2m ενώ οι μικρότεροι μόνο 1 m.

3. Θα χρειαστούμε έλξη στα τεταρτημόρια των κύκλων και το εργαλείο που κόβει τεμνόμενες γραμμές. 

Θα σχεδιάσουμε αυτό το αντικείμενο σε δύο βήματα. Πρώτα θα δημιουργήσουμε όλους τους κύκλους στα σωστά σημεία (σε αυτό το κεφάλαιο) και μετά θα τα επεξεργαστούμε έτσι, ώστε να πάρουμε το τελικό αποτέλεσμα (στο κεφάλαιο τροποποιήσεων των αντικειμένων).

1ο Βήμα: Σχεδιάζουμε τους κύκλους:

1. Ενεργοποιούμε το εργαλείο 'κύκλος' (Circle) και σχεδιάζουμε έναν κύκλο με τυχαία ακτίνα.


2. Επιλέγουμε τον κύκλο και  αλλάζουμε την ακτίνα του στο παράθυρο των ιδιοτήτων.

(Αν είναι ενεργό το εργαλείο των κύκλων, θα πρέπει να το απενεργοποιήσουμε πατώντας το πλήκτρο 'ESC')

3. Για να τοποθετήσουμε τους άλλους κύκλους ακριβώς στα τεταρτημόρια αυτού, ενεργοποιούμε την αντίστοιχη έλξη:

στα τεταρτημόρια  ('Quadrants')    [image: image1.png]



4. Ξεκινάμε πάλι το εργαλείο σχεδιασμού κύκλων και πηγαίνουμε κοντά σε ένα τεταρτημόριο του σχεδιασμένου κύκλου. Αμέσως ενεργοποιείται η έλξη σε αυτό και εμείς πατάμε το αριστερό πλήκτρο του ποντικιού, για να τοποθετηθεί εκεί το κέντρο του νέου κύκλου. Μετακινούμε λίγο το ποντίκι και ξαναπατάμε το ίδιο πλήκτρο, για να σχεδιαστεί ο κύκλος με τυχαία ακτίνα.


5. Από το παράθυρο ιδιοτήτων αλλάζουμε και αυτή την ακτίνα (1m).


6. Στο σχέδιο μας χρειαζόμαστε άλλους τρεις κύκλους, όμοιους με τον τελευταίο. Θα μπορούσαμε να επαναλάβουμε την τελευταία μας κίνηση άλλες τρεις φορές. Υπάρχει όμως και πιο γρήγορος τρόπος: Μπορούμε να αντιγράψουμε ένα αντικείμενο (τον μικρό κύκλο) όσες φορές θέλουμε. Κρατάμε το πλήκτρο 'Control' πατημένο και μετακινούμε τον μικρό κύκλο στο δεξί τεταρτημόριο, όπως φαίνεται στην παραπάνω εικόνα. Το αφήνουμε, μόλις ενεργοποιηθεί η κατάλληλη έλξη. Μόλις το αφήσουμε παρατηρούμε ότι μετακινήσαμε και τοποθετήσαμε ένα αντίγραφο του μικρού κύκλου που επιλέξαμε. Ακολουθούμε την ίδια διαδικασία άλλες δύο φορές για να ολοκληρωθεί αυτό το βήμα.


7.  Αποθηκεύουμε το σχέδιό μας για να συνεχίσουμε την επεξεργασία του σε επόμενο κεφάλαιο.

2.4 Απλές τροποποιήσεις των βασικών αντικειμένων

Αν επιλέξουμε ένα αντικείμενο, εμφανίζονται λαβές με διαφορετικά σύμβολα επάνω του. Ανάλογα με το είδος του αντικειμένου αυτές εμφανίζονται σε διάφορα σημεία. 

Σε ένα τόξο εμφανίζονται στα δύο άκρα του πράσινα κουτάκια. Αν πιάσουμε ένα από αυτά και το μετακινήσουμε, μεταφέρεται αυτό το άκρο, ενώ το άλλο παραμένει σταθερό. Επίσης αλλάζει και το κέντρο του.

Σε ένα ευθύγραμμο τμήμα μπορούμε να αλλάξουμε το μήκος του, χωρίς να επηρεάσουμε την κλίση του. Αρκεί να μετακινήσουμε ένα από τα πράσινα τρίγωνα που εμφανίζονται στα δύο άκρα του. Τα πράσινα τετράγωνα μας επιτρέπουν να μετακινήσουμε το συγκεκριμένο άκρο του.

Στο παραλληλόγραμμο εμφανίζονται μικρά τετράγωνα σε όλες τις πλευρές του, επιτρέποντάς μας να του αλλάξουμε το μέγεθος σε όποια κατεύθυνση θέλουμε. Μετακινώντας το τρίγωνο που εμφανίζεται στην μία του γωνία, μπορούμε να μετατρέψουμε όλες τις γωνίες του σε τόξα.

2.5 Εργαλεία τροποποίησης σχημάτων

Για να μπορέσουμε να συνθέσουμε ένα πολύπλοκο σχέδιο, σχεδιάζουμε με τα εργαλεία που μας δίνει το πρόγραμμα που δουλεύουμε και τα τροποποιούμε έτσι, ώστε να έχουμε το επιθυμητό αποτέλεσμα. 

Μερικά από τα βασικά εργαλεία τροποποίησης σχημάτων αφορούν το κόψιμο γραμμών σε συγκεκριμένα σημεία, την αντιγραφή, την μετακίνηση, την μεγέθυνση ή σμίκρυνση, την περιστροφή τους και την παράλληλη αντιγραφή τους.

Στην ομάδα εργαλείων τροποποίησης αντικειμένων συμπεριλαμβάνονται και αυτά, τα οποία μας επιτρέπουν την ευθυγράμμιση, αλλά και την τοποθέτησή τους ανά συγκεκριμένα διαστήματα. 


Ορισμένα από τα εργαλεία είναι:

Move: Μετακινεί ένα αντικείμενο ή μία επιλογή αντικειμένων. Επιλέγουμε το ή τα αντικείμενα, μετά το εργαλείο και τα μετακινούμε.

Rotate: Περιστρέφει ένα ή μία επιλογή αντικειμένων. Επιλέγουμε το ή τα αντικείμενα, μετά το εργαλείο και τα περιστρέφουμε. Έχουμε την δυνατότητα να μετακινήσουμε τον άξονα περιστροφής, πριν ξεκινήσουμε την περιστροφή.

Scale: Μεγέθυνση των επιλεγμένων σχημάτων. Επιλέγουμε το ή τα αντικείμενα, μετά το εργαλείο και τα μεγεθύνουμε. Μπορούμε να μετακινήσουμε το κεντρικό σημείο, γύρω από το οποίο γίνεται η μεγέθυνση.

Mirror: Καθρεφτίζει βάσει άξονα συμμετρίας. Αφού επιλέξουμε τα αντικείμενα και ενεργοποιήσουμε το εργαλείο, ορίζουμε τον άξονα συμμετρίας

Split: Κόβει ένα αντικείμενο (γραμμή, καμπύλη κλπ.) στο επιλεγμένο σημείο (δουλεύουμε με έλξεις). Επιλέγουμε πρώτο το εργαλείο και μετά το σημείο επάνω στο αντικείμενο.

Trim: Κόβει το κομμάτι ενός αντικειμένου, το οποίο τέμνεται από ένα άλλο, ακριβώς στο σημείο τομής και το σβήνει από την πλευρά που επιλέξαμε. Αφού ενεργοποιήσουμε το εργαλείο αυτό, επιλέγουμε τα κομμάτια, τα οποία θέλουμε να σβήσουν.

Extend: Προεκτείνει μία γραμμή μέχρι μία άλλη. Με ενεργοποιημένο το εργαλείο επιλέγουμε την γραμμή που θέλουμε να προεκταθεί μέχρι να βρει μία άλλη.

Fillet: Συνδέει δύο γραμμές με ένα τόξο συγκεκριμένης ακτίνας. Πρώτα επιλέγουμε τις δύο γραμμές και μετά ενεργοποιούμε το εργαλείο αυτό. Αμέσως εμφανίζεται ένα μικρό τρίγωνο, με το οποίο ρυθμίζουμε την ακτίνα του τόξου.

Offset: Δημιουργεί ένα νέο αντικείμενο παράλληλα και σε συγκεκριμένη απόσταση από το πρωτότυπό του.

Όλα τα παραπάνω εργαλεία μπορούν να ρυθμιστούν με το ποντίκι επάνω στο σχέδιο. 

Μερικά από τα παραπάνω εργαλεία ενεργοποιούνται και πατώντας το δεξί πλήκτρο του ποντικιού επάνω στο αντικείμενο.

Ορισμένα από αυτά επιτρέπουν την ρύθμισή τους και με το παράθυρο των ιδιοτήτων. Εκεί μπορούμε να ορίσουμε τις παραμέτρους της τροποποίησης.

Παραδείγματα τροποποιήσεων


1. Συνέχεια προηγούμενου παραδείγματος:

2ο Βήμα: Κόβουμε τους κύκλους

Στο παράδειγμα 2 του κεφαλαίου 2.2 σχεδιάσαμε το διπλανό σχήμα


Στην αριστερή εικόνα βλέπουμε το τελικό σχήμα.

Ποιο εργαλείο πρέπει να χρησιμοποιήσουμε για να ολοκληρώσουμε το σχέδιο;


Θα πρέπει με κάποιον τρόπο να κόψουμε ορισμένα κομμάτια από τους κύκλους. Το εργαλείο που ενεργοποιούμε είναι το Trim.

Αφού ενεργοποιήσουμε το Trim, μόλις ο δείκτης του ποντικιού μας έρθει σε μικρή απόσταση από ένα αντικείμενο, ενεργοποιείται η έλξη και το σημαδεύει. Πατάμε το αριστερό πλήκτρο του ποντικιού για να κόψουμε το συγκεκριμένο κομμάτι του αντικειμένου.


Το αποτέλεσμα της κοπής το βλέπουμε στην διπλανή εικόνα.

Συνεχίζουμε με την ίδια διαδικασία και κόβουμε όλα τα περιττά κομμάτια των κύκλων.


Στη διπλανή εικόνα βλέπουμε το τελικό αποτέλεσμα.

Στη συνέχεια θα δούμε ορισμένες ακόμα κινήσεις τροποποίησης αυτού του σχήματος.


Αρχικά θέλουμε όλο αυτό το σχήμα να γίνει ένα αντικείμενο, οι οκτώ γραμμές να ενοποιηθούν και να συμπεριφέρονται σαν μία. Το εργαλείο που έχει αυτό το αποτέλεσμα είναι το Join.

Επιλέγουμε όλο το σχήμα και ενώνουμε τις μεμονωμένες γραμμές με ένα απλό πάτημα στο εικονίδιο του εργαλείου 


Στο αντικείμενο βλέπουμε ότι έχουν φύγει οι περισσότερες λαβές και έχουν μείνει μόνο ορισμένες στις γωνίες του.

Τώρα θέλουμε να δημιουργήσουμε ένα λίγο πιο μεγάλο αντίγραφο του αντικειμένου μας γύρω από αυτό. Το εργαλείο που θα πρέπει να επιλέξουμε είναι το Offset.


Με το ποντίκι ή από το παράθυρο των ιδιοτήτων μπορούμε να ορίσουμε την απόσταση του αντιγράφου από το πρωτότυπο αντικείμενο. 


Το αντίγραφο θέλουμε να έχει απόσταση 17cm από το πρωτότυπο προς τα έξω. Όπως φαίνεται στο σχέδιο έχει αρνητική τιμή (στο παράθυρο ιδιοτήτων βλέπουμε:  -0,17m).

Δημιουργώντας το καινούριο αντικείμενο, βλέπουμε ότι αυτό καλύπτει το πρωτότυπο. Επειδή το καινούριο αντικείμενο είναι γεμάτο, 'βαμμένο' άσπρο χρώμα, δεν μπορούμε να δούμε το μικρότερο αντικείμενο που βρίσκεται από πίσω του. 

Υπάρχουν δύο λύσεις για το πρόβλημά μας:

1. Μπορούμε να αλλάξουμε την ιδιότητα 'χρώμα γεμίσματος' (Fill Color) για το αντίγραφο και να ορίσουμε 'κανένα' (None). Αμέσως το αντικείμενο θα γίνει διάφανο και θα φανεί το πρωτότυπο.


2. Μπορούμε να "στείλουμε" το καινούριο αντικείμενο που βρίσκεται επάνω πιο πίσω, δηλαδή πίσω από το πρωτότυπο. Αρκεί να χρησιμοποιήσουμε το εργαλείο Send Backward. 
Αφού επιλέξουμε το καινούριο αντικείμενο (αντίγραφο), πατάμε στο κατάλληλο εικονίδιο για να το στείλουμε πίσω από το πρωτότυπο.

Ένα αντικείμενο μπορούμε να στείλουμε και μπροστά (επάνω) από ένα άλλο. Αυτό γίνεται με το εργαλείο Bring Forward.


Στο συγκεκριμένο σχέδιο αλλάξαμε και το χρώμα γεμίσματος (Fill Color) σε πράσινο.


Η τελευταία μας κίνηση έχει σκοπό να 'ενώσει' τα δύο αντικείμενα, αλλά με άλλο τρόπο. Η εντολή Group μας επιτρέπει να 'κολήσουμε' τα αντικείμενα με τέτοιο τρόπο, ώστε να μην μπλέκουν τα επιμέρους αντικείμενα μεταξύ τους, αλλά κατά κάποιο τρόπο να παραμένουν μαζί

Με αυτό τον τρόπο διευκολυνόμαστε και στην μετακίνησή τους, αφού μετακινούνται πλέον μαζί. Για να τα απελευθερώσουμε πατάμε στο αντίστοιχο εργαλείο (Ungroup).

2. Το παρακάτω ευθύγραμμο τμήμα να περιστραφεί γύρω από τον άξονά του κατά 30(. 

α) Με την χρήση των ιδιοτήτων του αντικειμένου:

Επιλέγουμε το αντικείμενο. Στο παράθυρο των ιδιοτήτων του βλέπουμε όλα τα στοιχεία του. Μπορούμε να αλλάξουμε την γωνία του προσθέτοντας στις 45( τις 30( και αντικαθιστώντας το 45 με το αποτέλεσμα (75().

β) Με την χρήση της εντολής περιστροφής (rotate)

Επιλέγουμε με την σειρά πρώτα το αντικείμενο που θέλουμε να περιστρέψουμε και μετά το εργαλείο περιστροφής [image: image2.png]


 (ή πατάμε το δεξί πλήκτρο του ποντικιού). Το παράθυρο ιδιοτήτων του αντικειμένου αλλάζει και εμφανίζονται μόνο οι παράμετροι που αφορούν την περιστροφή: η γωνία (πληκτρολογούμε 60(), οι συντεταγμένες του κέντρου περιστροφής και ο αριθμός των αντιγράφων. Μπορούμε να ορίσουμε άλλο κέντρο περιστροφής είτε πληκτρολογώντας τις συντεταγμένες, είτε μετακινώντας το κίτρινο σύμβολο που εμφανίζεται στο αντικείμενο. Αν πληκτρολογήσουμε και αριθμό αντιγράφων, τότε γίνονται τόσες περιστροφές, όσα αντίγραφα ορίσαμε και η διαφορά της γωνίας μεταξύ τους είναι η γωνία περιστροφής


Αν στο συγκεκριμένο παράδειγμα πληκτρολογήσουμε 3 αντίγραφα με 30( γωνία και κέντρο περιστροφής το κάτω άκρο του ευθύγραμμου τμήματος, το αποτέλεσμα θα είναι:

γ) Με την χρήση του ποντικιού

Επιλέγουμε το αντικείμενο και το εργαλείο περιστροφής. Κρατάμε το αριστερό πλήκτρο του ποντικιού πατημένο επάνω στο ένα άκρο του αντικειμένου και το περιστρέφουμε. Αν κρατήσουμε και το πλήκτρο 'shift' ταυτόχρονα πατημένο, το αντικείμενο μετακινείται με βήμα 15(. Για να δημιουργήσουμε αντίγραφα, μπορούμε να κρατήσουμε πατημένο και το πλήκτρο 'control'.

2.6 Ένα τοπογραφικό διάγραμμα

Έχουμε να σχεδιάσουμε ένα οικόπεδο:

Για να μπορέσουμε να σχεδιάσουμε το οικόπεδο και να τοποθετήσουμε σωστά το κτίριο, χρειαζόμαστε κάποιες επιπλέον μετρήσεις (στην παραπάνω εικόνα με πράσινο χρώμα και διακεκομμένη γραμμή).

Τα βήματα που πρέπει να ακολουθήσουμε για να σχεδιάσουμε το τοπογραφικό διάγραμμα είναι τα εξής:

1. Ξεκινάμε το σχέδιο με τις κάθετες πλευρές ΑΒ και ΑΕ

2. Τις πλευρές ΒΓ, ΓΔ και ΔΕ τις σχεδιάζουμε με την βοήθεια των δεδομένων αποστάσεων ΑΓ και ΑΔ.

3. Την Οικοδομική Γραμμή τη σχεδιάζουμε μετακινώντας ένα αντίγραφο της Ρυμοτομικής Γραμμής κατά 4 m.

4. Ξεκινάμε το κτίριο από την αριστερά επάνω γωνία του, μια που ξέρουμε την απόστασή της από δύο σημεία και μπορούμε να την καθορίσουμε.

Παρακάτω παρουσιάζονται τα κυρίως βήματα, μια που έχουμε μάθει όλες τις ενδιάμεσες κινήσεις:

1. Ρυθμίζουμε το μέγεθος χαρτιού, μονάδα μέτρησης, κλίμακα κλπ.
Σχεδιάζουμε και τροποποιούμε τις κάθετες πλευρές ΑΒ και ΑΕ έτσι ώστε να έχουν το σωστό μήκος.


2. Για να σχεδιάσουμε τις πλευρές ΒΓ, ΓΔ και ΔΕ μας δίνονται οι αποστάσεις από την γωνία Α. Αυτό μας βοηθάει να βρούμε τα συγκεκριμένα σημεία δημιουργώντας κύκλους με γνωστή ακτίνα (μήκος πλευράς, απόσταση από κάποια πλευρά). 


Το ζητούμενο σημείου Γ είναι το σημείο τομής των δύο κύκλων.

Με τον ίδιο τρόπο τελειώνουμε το σχεδιασμό του οικοπέδου.


3. Την Οικοδομική Γραμμή τη σχεδιάζουμε αντιγράφοντας παράλληλα τις γραμμές ΑΒ και ΒΓ.

Μετά το σχεδιασμό του οικοπέδου, έρχεται η σειρά στο κτίριο. Πρέπει να το τοποθετήσουμε σωστά στο σχέδιό μας. Γνωρίζοντας την απόσταση της αριστερής επάνω γωνίας του από τα σημεία Ε και Δ ακολουθούμε την ίδια διαδικασία που χρησιμοποιήσαμε στο σχεδιασμό των πλευρών του οικοπέδου.

Το (προσωρινά) τελικό αποτέλεσμα που βλέπουμε στην παραπάνω εικόνα το αποθηκεύουμε για να το συνεχίσουμε (διαστάσεις) σε επόμενο κεφάλαιο.

Θα πρέπει να κάνουμε όμως και τον υπολογισμό του εμβαδού

Για να υπολογίσουμε το εμβαδόν πρέπει να χωρίσουμε το οικόπεδο σε (νοητά) τρίγωνα. Ξέρουμε ότι το εμβαδόν ενός τριγώνου υπολογίζεται με τον τύπο: (βάση x ύψος) / 2.

Χωρίζουμε το οικόπεδο σε τρίγωνα: ΑΒΓ, ΑΓΔ και ΑΔΕ.

Πώς θα βρούμε το ύψος του κάθε τριγώνου;

Αρκεί να σχεδιάσουμε μία κάθετη γραμμή από μία γωνία σε μία πλευρά και να την μετρήσουμε.

Ένας εύκολος τρόπος να σχεδιάσουμε αυτά τα ύψη είναι η αντιγραφή και περιστροφή της άλλης κάθετης (δηλαδή της βάσης). 

Η γραμμή που δημιουργήθηκε με γωνία 90ο, αρκεί να τοποθετηθεί με το ένα άκρο της στην απέναντι γωνία του τριγώνου.


Με μία κίνηση ακόμα έχουμε δημιουργήσει το ύψος του τριγώνου: 

· Αν η γραμμή εξέχει θα πρέπει να κοπεί (trim)
· Αν δεν ακουμπάει την βάση θα πρέπει να προεκταθεί (extend)
Το μήκος αυτής της γραμμής (το ύψος του τριγώνου) που δημιουργήσαμε μπορούμε να το βρούμε στο κελί Length στο παράθυρο των ιδιοτήτων του αντικειμένου (αρκεί να το έχουμε επιλεγμένο).

Υπολογισμός του συνολικού εμβαδού του οικοπέδου:

Ε= 0,5 x 25 x 9,46 + 0,5 x 25 x 8,8 + 0,5 x 19 x 8,43 = 308,34 m2 

Ένας άλλος τρόπος υπολογισμού του εμβαδού είναι ο τύπος του Ήρωνα
2.7 Επισκόπηση κεφαλαίου

Σε αυτό το κεφάλαιο γνωρίσαμε

· Τα βασικά εργαλεία σχεδιασμού,

· Τον σχεδιασμό με έλξεις,

· Τις τροποποιήσεις των αντικειμένων

· Βασικές λειτουργίες και χειρισμούς

Στο τέλος αυτού του κεφαλαίου θα πρέπει να ξέρεις

· Να σχεδιάζεις απλά αντικείμενα,

· Να χρησιμοποιείς τις έλξεις,

· Να τροποποιείς με τα εργαλεία τροποποίησης τα βασικά αντικείμενα,

· Να σχεδιάζεις τοπογραφικά διαγράμματα,

· Να υπολογίζεις το εμβαδόν ενός οικοπέδου

3 Απλοποίηση και αυτοματισμοί σχεδίων

Θα δυσκολευτούμε να αναγνωρίσουμε λεπτομέρειες ή ακόμα και να καταλάβουμε ένα σχέδιο, όταν σε αυτό υπάρχουν χίλιες δυο γραμμές, σε μικρή απόσταση η μία από την άλλη. Με την χρήση των κατάλληλων μεθόδων και εργαλείων που μας προσφέρουν τα σχεδιαστικά προγράμματα, μπορούμε να τα απλοποιήσουμε. Το κεφάλαιο αυτό θα μας βοηθήσει να κατανοήσουμε γιατί και πώς γίνονται αυτές οι κινήσεις.

3.1 Απλοποίηση πολύπλοκων σχεδίων (στρώσεις XE "στρώσεις" )

Σε ένα σχέδιο μπορεί να έχουν ενσωματωθεί διάφορα επιμέρους σχέδια. Σε μία κάτοψη π.χ. μπορεί να έχουμε βάλει και την επίπλωση, το ηλεκτρικό και υδραυλικό σχέδιο και διάφορες άλλες πληροφορίες. Αν εμφανίσουμε όλα αυτά ταυτόχρονα στην οθόνη μας ή στην εκτύπωση, μάλλον θα μπερδευτούμε πιο πολύ λόγω του πλήθους των γραμμών, ειδικά αν πρόκειται για ασπρόμαυρο σχέδιο. Έχουμε όμως τη δυνατότητα να σχεδιάσουμε σε διαφορετικές στρώσεις (layers XE "layers" ) και να ενεργοποιούμε ή να απενεργοποιούμε συγκεκριμένες στρώσεις. Μπορούμε να τις φανταστούμε σαν διαφάνειες. Ανάλογα με το σχέδιο που μας ενδιαφέρει, τοποθετούμε ή αφαιρούμε σε μία στοίβα τις αντίστοιχες διαφάνειες. 

Οι ιδιότητες που έχει μία στρώση είναι:

Name
Το όνομά της

Active
Η ενεργή στρώση (σε αυτήν σχεδιάζουμε το επόμενο αντικείμενο) 

Visible
Αν είναι ορατή (και εκτυπώνεται)

Select
Αν μπορούμε να επιλέξουμε αντικείμενα που βρίσκονται σε αυτή

Snap
Αν οι έλξεις πιάνουν σε αντικείμενά της

Color
Το χρώμα με το οποίο σχεδιάζονται τα αντικείμενά της

Ένα αντικείμενο δεν πρέπει υποχρεωτικά να ανήκει σε κάποια στρώση. 

Καλό είναι τη στιγμή που σχεδιάζουμε να τοποθετούμε τα αντικείμενα κατευθείαν στην σωστή τους στρώση. Δεν είναι όμως απαραίτητο. Μπορούμε ανά πάσα στιγμή να μεταφέρουμε τα αντικείμενα από μία στρώση σε άλλη, απλά τα επιλέγουμε και μετά επιλέγουμε την στρώση στην οποία θέλουμε να τοποθετηθούν.

Το παράθυρο των στρώσεων ενεργοποιείται από το μενού Format > Layers ή από την γραμμή εργαλείων 'Layers'.
3.2 Drawing Planes - Το σχέδιο μέσα στο σχέδιο

Στο μενού Format, θα βρούμε την επιλογή των σχεδιαστικών επιπέδων (Drawing Planes). Είναι μία λειτουργία παρόμοια με τις στρώσεις (Layers), μόνο που κάθε σχεδιαστικό επίπεδο μπορεί να έχει 

· διαφορετική μονάδα μέτρησης (units),

· άλλη κλίμακα (scale) και

· διαφορετικές στρώσεις (layers).

Τις επιλογές των σχεδιαστικών επιπέδων θα τις βρούμε στο μενού Format > Drawing Planes.


Οι ιδιότητες των σχεδιαστικών επιπέδων:

Name (όνομα): 
Το όνομα του σχεδιαστικού επιπέδου

Active (ενεργό): 
Το τρέχον σχεδιαστικό επίπεδο. Σε αυτό σχεδιάζουμε

Visible (ορατό): 
Αν είναι ορατά τα αντικείμενά του στο σχέδιο.

Snap (έλξη): 
Αν λειτουργούν οι έλξεις (snaps) στα αντικείμενά του

Link (σύνδεση): 
Όταν έχει ενσωματωθεί ένα αρχείο εμφανίζεται η διαδρομή και το όνομά του

Για να ενεργοποιήσουμε μία ιδιότητα (εκτός της σύνδεσης) αρκεί να την επιλέξουμε στην αντίστοιχη στήλη ώστε να εμφανιστεί το σύμβολο (.
Οι επιλογές που έχουμε στο ίδιο παράθυρο είναι:

Add (πρόσθεσε): Για να προσθέσουμε καινούρια σχεδιαστικά επίπεδα

Remove (αφαίρεσε): Για να αφαιρέσουμε ένα σχεδιαστικό επίπεδο

Move Up (μετακίνησε προς τα πάνω): Αλλάζουμε την σειρά προτεραιότητας στην εμφάνιση των αντικειμένων προς τα πάνω

Move Down (μετακίνησε προς τα κάτω): Αλλάζουμε την σειρά προτεραιότητας στην εμφάνιση των αντικειμένων προς τα  κάτω

Settings (ρυθμίσεις): Ρυθμίσεις για μονάδα μέτρησης, κλίμακα κλπ. όπως σε κάθε σχέδιο

Για να δημιουργήσουμε ένα καινούργιο επίπεδο ξεκινάμε την διαδικασία επιλέγοντας Add από το παράθυρο των σχεδιαστικών επιπέδων. Στο παράθυρο που ανοίγει επιλέγουμε αν θέλουμε την εισαγωγή ως

· Σχεδιαστικό επίπεδο με δυνατότητα επεξεργασίας

· Φόντο στο τρέχον σχέδιο, χωρίς δυνατότητα επεξεργασίας.

3.3 Εισαγωγή ενός σχεδίου AutoCAD
Πολλές φορές υπάρχει η ανάγκη να εισάγουμε ένα σχέδιο του AutoCAD στο δικό μας. Μπορεί να χρειαστεί να εμπλουτίσουμε ένα σχέδιο του AutoCAD με ενεργά σχήματα (από το δικό μας πρόγραμμα). Για να μπορέσουμε να εισάγουμε σωστά ένα τέτοιο σχέδιο, υπάρχει μία ειδική εντολή στο μενού Insert: AutoCAD Drawing.

Για να ολοκληρωθεί η εισαγωγή, θα πρέπει να ορίσουμε τον τρόπο με τον οποίο θα γίνει και πώς θα εμφανίζεται το σχέδιο στην οθόνη μας. Υπάρχει μία σειρά από παράθυρα που θα ανοίξουν διαδοχικά. Εκεί θα γίνουν όλες οι απαραίτητες ρυθμίσεις.

Το πρώτο παράθυρο αρχικά μας ρωτάει αν θέλουμε να εισαχθεί στο τρέχον σχέδιο ή σε ένα καινούριο. 

Η επόμενη ερώτηση στο ίδιο παράθυρο ζητάει να ξεκαθαρίσουμε αν το σχέδιο θα εισαχθεί ως 

· Ενεργό φόντο (οι έλξεις δουλεύουν),

· Ένα ενεργό σχήμα ή

· Ανεξάρτητα αντικείμενα (ευθύγραμμα τμήματα, τόξα κλπ.).

Στο δεύτερο παράθυρο ορίζουμε την μονάδα μέτρησης η οποία έχει χρησιμοποιηθεί στο σχέδιο του AutoCAD και το τρέχον μέγεθος χαρτιού.

Στη συνέχεια πρέπει να προσαρμοστεί το μέγεθος του εισαγόμενου σχεδίου. Μπορούμε να καθορίσουμε έναν συντελεστή ή να επιλέξουμε μία αυτόματη προσαρμογή στο μέγεθος της ρύθμισης σελίδας. Επίσης μπορούμε να ζητήσουμε την τοποθέτηση στο κέντρο της σελίδας ή με κάποια απόσταση από την αρχή του επιπέδου.

Στο τέταρτο παράθυρο επιλέγουμε τις στρώσεις που θα εισαχθούν (και τα αντικείμενα σε αυτές!)

Σε περίπτωση που υπάρχει στρώση με το ίδιο όνομα στο τρέχον σχέδιο, τα αντικείμενα εισάγονται σε αυτή.

Αν το σχέδιο του AutoCAD περιλαμβάνει και διαγράμμιση, μπορούμε στο τελευταίο παράθυρο να ορίσουμε αν θέλουμε

· Να μετατραπεί στην πλησιέστερη διαγράμμιση του προγράμματός μας

· Να μην εισαχθεί

· Να εισαχθεί και να διασπαστεί σε μεμονωμένες γραμμές


3.4 Βιβλιοθήκες έτοιμων συμβόλων

Πολλά από τα σχήματα ενός σχεδίου επαναλαμβάνονται είτε στο ίδιο είτε σε άλλα. Για να μην τα σχεδιάζουμε από την αρχή κάθε φορά, μπορούμε να τα αποθηκεύουμε, έτσι ώστε να τα έχουμε έτοιμα όποτε τα χρειαζόμαστε. Χρήσιμη είναι η λειτουργία αποθήκευσης ορισμένων επιπλέον χαρακτηριστικών τέτοιων σχεδίων, όπως π.χ. ο κωδικός κατασκευαστή του συγκεκριμένου αντικειμένου, η τιμή κ.α.

Τα έτοιμα σύμβολα του προγράμματός μας είναι ενεργά σχήματα XE "ενεργά σχήματα"  (ActivShapes XE "ActivShapes" ). Κάποια τοποθετούνται αυτόματα, άλλα εμφανίζουν διάφορα στοιχεία τους ανάλογα με τις ρυθμίσεις μας.

Τα ενεργά σχήματα είναι αποθηκευμένα σε καταλόγους. Ανάλογα με το σχέδιό μας μπορούμε να φορτώσουμε τέτοιους καταλόγους ή να δημιουργήσουμε καινούριους. 

Με τις επιλογές που έχουμε από το παράθυρο των ενεργών σχημάτων, μπορούμε



New Catalog XE "Catalog" 
να δημιουργήσουμε έναν καινούργιο κατάλογο



Open Catalog
να φορτώσουμε από το δίσκο έναν κατάλογο στο σχέδιό μας



Save Catalog as
να αποθηκεύσουμε έναν κατάλογο από το σχέδιό μας στο σκληρό δίσκο και



Close Catalog
να κλείσουμε έναν ανοικτό κατάλογο του σχεδίου μας

Για να εισάγουμε ένα ενεργό σχήμα στο σχέδιό μας πρέπει

· πρώτα να φορτώσουμε την βιβλιοθήκη του στο σχέδιο και

· μετά το επιλέγουμε και το σέρνουμε με το ποντίκι μέσα στο σχέδιό μας.

Αφού το έχουμε πλέον εισάγει, μπορούμε εύκολα να το αντιγράφουμε μέσα στο σχέδιο.

Ορισμένα από αυτά, αλλάζουν μορφή ή έχουν αυτοματισμούς για την τοποθέτησή τους στο σχέδιο. Αυτές τις επιλογές όπως και τα υπόλοιπα χαρακτηριστικά ενός ενεργού σχήματος μπορούμε να τα ελέγξουμε πατώντας το δεξί κουμπί στο ποντίκι.

Υπάρχει ένα ειδικό παράθυρο για τα ενεργά σχήματα. Σε αυτό εμφανίζονται τα ενεργά σχήματα του ανοιχτού καταλόγου και όλοι οι φορτωμένοι κατάλογοι. Επίσης υπάρχουν ειδικά εικονίδια για τις λειτουργίες των καταλόγων. Αν δεν υπάρχει στην οθόνη μας το παράθυρο των ενεργών σχημάτων, απλά πατάμε το πλήκτρο F8.

Στα ενεργά σχήματα υπάρχουν δύο βοηθήματα για την τοποθέτηση των σχημάτων αλλά και την διασύνδεση μεταξύ τους. Πρόκειται για

· τους οδηγούς (Plugs) XE "Plugs" , οι οποίοι συνδέονται σε οδηγούς και υποδοχές, και 

· τις υποδοχές (Sockets) XE "Sockets" , οι οποίες δέχονται μόνο plugs
Κατά τον σχεδιασμό ενός ενεργού σχήματος μπορούμε να καθορίσουμε την γωνία αυτών των βοηθημάτων. Έτσι, όταν συνδέονται δύο ενεργά σχήματα, προσανατολίζονται σύμφωνα με τις ρυθμίσεις μας.

Παράδειγμα 1ο: Φορτώνουμε τον κατάλογο των οργανογραμμάτων 'Basic Flowchart' από το φάκελο 'business'. Εκεί θα βρούμε το ενεργό σχήμα 'Multishape'. Αυτό έχει την δυνατότητα να αλλάζει μορφή. 

Με πατημένο το αριστερό πλήκτρο του ποντικιού επάνω του, το σέρνουμε και το εισάγουμε στο σχέδιο.

Μετά το επιλέγουμε με το δεξί πλήκτρο του ποντικιού. Αμέσως ανοίγει ένα παράθυρο, στο οποίο μπορούμε  να ορίσουμε τη μορφή του (process, decision, data, document).


Ανάλογα με την επιλογή μας, το ενεργό σχήμα αλλάζει μορφή.

Θυμήσου: Με τα πλήκτρα 'shift' και 'ctrl' μπορούμε να αντιγράψουμε και να περιορίζουμε την μετακίνηση.

Άσκηση: Να σχεδιαστεί το παρακάτω (αντιγράφουμε το ενεργό σχήμα, του αλλάζουμε μορφή και τα συνδέουμε μεταξύ τους με το εργαλείο 'connector')

Πρόσεξε ότι τα συνδέουμε στα σημεία όπου υπάρχουν υποδοχές (θα πρέπει να έχεις ενεργοποιημένη την έλξη στις υποδοχές).

Παράδειγμα 2ο: Φορτώνουμε τον κατάλογο των γραφείων 'Desks and Workstations' από τον φάκελο 'Facilities'.

Τοποθετούμε την κολώνα 'four corner post', πάνω στην οποίο μπορούμε να συνδέσουμε δύο τοίχους 'Wall panel' (μήκους ....). 

Εισάγουμε μία γωνία γραφείου 'corner 2' και την τοποθετούμε στην γωνία, όπως φαίνεται και στο παρακάτω σχήμα. Πρόσεξε ότι προσαρμόζεται αυτόματα.

Μετά εισάγουμε τα έπιπλα 'desk' και 'bullet desk', τα οποία τοποθετούμε στις δύο πλευρές της γωνίας.

Μας λείπει ακόμα το κάθισμα, το οποία θα βρούμε στον κατάλογο 'seating'. Αυτό το τοποθετούμε και το τροποποιούμε έτσι, ώστε το τελικό αποτέλεσμα να είναι σαν το παρακάτω σχήμα.

3.5 Επισκόπηση κεφαλαίου

Σε αυτό το κεφάλαιο γνωρίσαμε

· Τις στρώσεις (Layers)
· Τα σχεδιαστικά επίπεδα (Drawing Planes)
· Την εισαγωγή σχεδίων από το AutoCAD
· Τις βιβλιοθήκες έτοιμων συμβόλων (ActiveShapes)
Στο τέλος αυτού του κεφαλαίου θα πρέπει να ξέρεις

· Να δημιουργείς και να ρυθμίζεις στρώσεις.

· Να δημιουργείς και να ρυθμίζεις σχεδιαστικά επίπεδα.

· Να εισάγεις σχέδια του AutoCAD.
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Το μενού Draw
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Το μενού View
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Οι ρυθμίσεις των στρώσεων





�


Τα ενεργά σχήματα
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